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INTRODUCTION 

Before Getting Started:  
Please read the entire manual before using the software. 

About AVL 

AVL Looms has been in the business of designing and building some of the 

world’s finest handweaving looms since 1977. 

Jim Ahrens had been building and designing looms for a number of years 
before Jon Violette, the “V” in AVL, approached Ahrens about a partnership 

in 1977.Violette, an industrial management professional, had discovered 
Ahrens’ work through his sister who ran the Pacific Basin School of Textiles 

in Berkeley, where Ahrens was a volunteer advisor. 

The two men worked together in the Bay Area for three years until Violette 
moved Ahrens and Violette Looms to Chico, where it officially became known 

as AVL Looms Inc., and has operated ever since. 

In 1982, Violette was instrumental in the development of the first 

computerized dobby, then called the “Apple Dobby”. He retired from active 
life in the company in 1987. 

Once known for our production looms, AVL has broadened its line 

considerably and we now offer customers a full spectrum of fine weaving 
equipment, ranging from our small Home Looms, to our Industrial Dobby 

Looms, Rug Looms, and Jacquards. 

The Compu-Dobby 5 Design Concept 

The guiding concept behind the Compu-Dobby 5 is ease of use with precise, 
repeatable control. The loom is designed to be easy to thread, easy to setup 

and easy to weave on. 

LOOM FEATURES 

Compu-Dobby® 

A first for handweaving looms, the Compu-Dobby 5 enables computer 

control of pattern and key loom functions, including warp tension and pick 
spacing. 
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Pattern control is a state of the art system that eliminates the multi-treadle 

dance of traditional looms and the tedious pegging of mechanical dobby 
looms. Much like the legacy cartridge systems from the Compu-Dobby I and 

II, the Compu-Dobby 5 stores entire weaving files (WIFs) onboard with three 
significant advantages over all other systems: 

 Ultra-fast pick writing. The system can achieve weaving speeds 

in excess of 100 picks per minute. 

 Hundreds of weaving files may be stored for later use. 

 Eliminates latency timing issues inherent in computer 

communications systems. Latencies can cause slower weaving 

and even missed picks. 

As a web enabled device, this loom connects to your computer or tablet via 

WiFi or USB and controls the loom from your favorite browser. AVLDrive 
version 5 is an easy to use, intuitive interface run from within the Compu-

Dobby 5. As a direct result, there is no software to install for the loom, nor 
limitation on the controlling device, except for a minimum screen resolution 

(1024 x 768 pixels). AVLDrive is compatible with all major browsers, including 

Safari, Chrome, Edge, Firefox and Opera. The current version of the browser 
should be used. 

Warp Beams and Automatic Warp Tension System  

A first in our industry, some looms offer digital control of warp tension using 

a small electrical motor and drive system connected via spring and brake 
cable to the warp beam. The motor is controlled by the Compu-Dobby & 

AVLDrive. Easily change the warp tension at any time during weaving by a 
click of the mouse or a touch of the finger on the touchscreen. This system 

allows very fine, repeatable control with a range from locked beam to free 
turning for winding on the warp. 

Note: 
If you have a Compu-Dobby 5 on a loom with an automatic warp tension 

system and automatic cloth advance, see the section starting on page 54 for 

complete details on using these features. 

Automatic cloth advance is an AVL-only feature on hand weaving looms. 
Earlier mechanical versions of these systems are well known for providing 

fine control over pick advance spacing. This feature utilizes digital controls 
via an electric motor driven worm and gear attached directly to the cloth 

beam. Much like the digital warp tension controls, set the picks per inch in 
AVLDrive and start weaving. Easily change the advance setting or manually 
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advance the cloth at any time during weaving by a click of the mouse or a 

touch of the finger on the touchscreen. This system allows very fine, 
repeatable control with a range from hundreds of picks per inch (or 

centimeter) to gross movements needed when starting a new warp.
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CONNECTING TO 

THE LOOM 
ATTENTION:  

Please read through this entire section before powering on your loom. 
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CONNECTION TYPES 

In order to connect to the loom, your device must either have a USB port or 
the ability to connect to the internet. There are three ways to connect a 

device to the loom: 

Connection Type Description 

USB  USB cable from your device to the loom. Only 
devices with USB ports can connect this way.  

LAN (Local Area 

Network) 

Through a router. Only devices with WiFi can 

connect this way. 

LoomDirect Connection to the loom’s local WiFi network 
(not through a router). Only devices with WiFi 

can connect this way. 

 

The software interface (AVLDrive) is web browser based so you do not need 

to download anything. Simply open your standard web browser (Chrome, 
Safari, Firefox, etc.) and type in the loom’s address. 

When the loom is started, it will try to connect to the router (LAN) it is 

normally connected to first. If it cannot find the router, it will start 
LoomDirect. The USB connection is always available. 

LOOM MODES 

The loom is designed to be controlled through the AVLDrive software, so 
there is no “power” button anywhere on the loom. 

We recommend the use of a good surge protector between the outlet and 

UPS on the Compu-Dobby 5, especially in regions subject to lightning strikes 
and other extreme electrical anomaly incidences. In areas prone to 

brown/black out or power grid fluctuations, we recommend a 800W, 1000VA 
UPS for Compu-Dobby 5 equipped loom. 

Standby Mode: 

When you plug the loom in it enters Standby Mode. The loom is designed to 

be left plugged in and in Standby Mode at all times. In standby power mode, 
the loom consumes very little power, and maintains the network connection 

to the router or LoomDirect WiFi. 
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Note:  

Avoid pulling the power cord while the loom is in standby power mode. 
Please use the Shutdown menu option to completely power down the loom 

prior to pulling the power cord from the electrical socket. 

Weaving Mode: 

Weaving mode is when the loom and all its digital controls have been 
powered on through AVLDrive. You will hear the warp tension motors set 

into place and other digital features come to life.  

WARNING:   
Do not pull or cut power to the loom while in Weaving mode.  

Shutdown Mode: 

This mode allows you to shut down the loom properly so that power can be 

removed. It can be initiated from Weaving Mode or Standby Mode through 
AVLDrive. Shutting down the loom through AVLDrive is the proper way to 

stop all power to the loom. Once the loom has been shutdown the power 
cord can be unplugged. 

If the loom has been Shutdown through the software, but is still plugged in, 

simply unplugging it and plugging it back in will initiate Standby Mode.  

POWERING ON THE LOOM 

When powering on the loom for the first time, you will need to use either a 

USB connection or connect via LoomDirect. In order to connect via a router 
(LAN), you will have to setup the Network information on the loom using one 

of the other connection types first. Once setup you can then connect via 
router each time you come to the loom. However, if Wifi connections are 

ever lost you can always revert to USB or LoomDirect. 

1) Connect the loom to power via the provided power cable. All lights 
but the “Error” light will light up as shown in the images below. 
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2) Wait for the loom to bootup. This may take up to several minutes. 
Once ready the loom will show just the “Power” and “Network” 
lights. The network light may be Green or Red. 

 

LED Lights 

The loom uses a lighted interface for communication with the weaver. 

Light Name Description 

POWER Orange light means “power” to the loom in standby mode. 

Red light means “power” to the loom in weaving mode. 

NETWORK Different colors indicate the network status. 
Blinking Red: searching for a router. 

Red: connected to a router 
Green: LoomDirect is available (not searching for a router). 

COM Green light shows the loom is connected to a device. No light 

means there is no device connected.  

ERROR Red light will shine when an error has occurred.  

SHED Red light will shine when shed open. Green light will shine 

when shed closed. If the dobby is in between states (shed 
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null), it will be unlit. 

SETTING UP COMMUNICATION 

Connecting via USB 

When using a USB, a cable is attached from your device to the loom. If you 

are not using the USB connection, remove the cable from the device. 

1) Plug the normal USB plug into your device and plug the other end 
into the Compu-Dobby. 

2) Open an Internet browser program on your device (Chrome, 

Internet Explorer, Microsoft Edge, Firefox, Opera, etc.). 

3) In the Address Bar, type in 192.168.6.2 when using a Mac or 
192.168.7.2 when using a Windows PC and press Enter to open 

AVLDrive. This is the IP address for the loom when connecting via 
USB. You can also use the Loom Name URL once it has been setup. 

Note:  
Any time you’re connected via USB you can use the IP address or the loom 

name to open AVLDrive. If the loom name is entered, and a USB cable is 

connected to the loom and the device, the loom will default to using the USB 
cable, even if a network connection is setup. 

 

4) When the device is connected, the COM Light will come on. The 
COM light indicates only that a device is connected. 
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Connecting via LoomDirect 

LoomDirect means the loom is generating its own WiFi network and will 

show up as an available network on your device. The great part about this 
feature is that you don’t need to be actively connected to the internet to 

wirelessly connect to the loom. However, your computer must still have the 
capability to connect to the internet. 

The loom’s protocol is to first search for a router to connect to. If it does not 

find one, it will automatically switch to LoomDirect and create its own 
network. 

Note: 

If no router (LAN) connection is established your loom will automatically 
switch to LoomDirect.  

1) Wait for the loom to switch to LoomDirect and the private network 

to show up on your device. This should occur quickly. 

2) When the Network light shines green, the loom is now putting off its 

own network that can be found from your device.  

3) The network will be AVL_[loom_serial_number] where 
loom_serial_number is the serial number for your loom. 

Note: 

The loom serial number is shown on a plate affixed to the front of the castle 
on your loom. 

4) Connect your device (laptop, tablet, phone) to this WiFi network.  
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5) The password for the network will be CompuDobby5. 

6) Open your browser and type in 192.168.16.2, or the name of the 

loom if you’ve named it.  

Note: 
If the loom name is entered, and a USB cable is connected to the loom and 

the device, the loom will default to using the USB cable, even if a network 
connection is setup. 

7) When the device is connected, the COM Light will come on. The 

COM light indicates only that a device is connected. 

8) Once you establish the LoomDirect connection you won’t have to go 
through this process again. You can shut down your loom and you’ll 

be able to turn the loom on and connect to AVLDrive automatically.  

Note: 
If you switch to a new device, you will need to connect to LoomDirect on the 

new device and enter the Network ID and password. 
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Setting up Network settings to connect via router 

For this connection, you will connect using your router at your location. The 

router allows you to access the internet wirelessly on your device. Both your 
computer and the loom will be connected to the same network. In order to 

use this connection type, you must have access to the internet. 

If you don’t have internet, you can still connect via WiFi with LoomDirect 
connection covered in its own section. 

1) Connect your device to the loom via USB or LoomDirect. 

2) Go to Network tab in AVLDrive. 

3) Click Enable Router Connection. 

 

4) Select your network from the dropdown list and enter the password 
for your router.  

5) Click the Restart Network button.  

6) Unplug the USB or disconnect from LoomDirect. The COM light will 
go off, indicating that no device is connected. You will also note that 

the Network light will change. Wait for the network light to be solid 
red again before continuing. 
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Note: 

The network light should remain RED during these steps, indicating that the 
Compu-Dobby is connecting to a router. If your network light turns GREEN, 

the Compu-Dobby has started LoomDirect. Check the password for your 
router and re-enter the password. If the loom still does not connect to the 

router, make sure that the router is working correctly. 

7) Wait for the WiFi connection to the loom. It can take up to several 
minutes for the loom to connect to the router. 

8) Connect your device (laptop, tablet, phone) to the same WiFi 

network you connected the loom to.  

 

9) You can refresh your browser.  

10) When the device is connected, the COM Light will come on. The 

COM light indicates only that a device is connected. 

11) Once you establish the router connection you won’t have to go 
through this process again. You can shut down your loom and you’ll 

be able to turn the loom on and connect to AVLDrive without these 
steps.  

Note:  

If your router name or password changes, you will have to setup the network 
using the USB or LoomDirect. 

LOST CONNECTION 

If the loom loses its connection to the router while in standby power mode, 
follow these steps to reconnect. 

1) In the software, go to the Utilities tab. 

2) Click Shutdown. 
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3) Once the loom has completed the shutdown sequence and the LEDs 

have turned off, remove power from the loom. 

4) Plug the loom back in. 

5) The loom will perform a normal boot up and then reconnect to the 

router. 

NAMING YOUR LOOM 

Install Bonjour Print Services for Windows 

If you have a Windows computer, you will have to install Bonjour Print 

Services in order to use a loom name. This software is a default part of a 
Mac computer. There is no similar software for Android. If are using an 

Android device or you prefer not to install the software on your Windows 
computer, you can continue to use the IP address to access AVLDrive. 

Bonjour Print Services for Windows lets you access AVLDrive via your web 

browser using your "loom name" as the URL. Example: http://[loom 
name].local. This service needs to be downloaded and installed on your 

computer.  

1) Go to https://support.apple.com/kb/DL999?locale=en_US. 

 

2) Click the Download button. The file will be downloaded to a location 
on your computer. For Windows computers, this will most often be 

the Download folder. 

https://support.apple.com/kb/DL999?locale=en_US
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Note: 

Depending on your browser, you will see a notice that the file is being 
downloaded at either the top or bottom of the screen. Once the download is 

complete, you may be able to click on the notification to open and install the 
software. 

3) Navigate to the correct folder. 

 

4) Open the downloaded file to initiate the install wizard. 

 

Add Loom Name 

Naming your loom is an important step that will make it easy to access your 

loom via WiFi from any device.  
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This creates a URL that you type in to the address bar on a web browser. It 

will be easy to remember, unlike the IP address. Your loom name can be 
changed at any time. 

The LOOM URL will be http:// + [loom name] + .local 

Example:  

Loom name = myloom 

Loom URL = http://myloom.local 

Note: 

The name must be a solid piece of text with no spaces. If a space is added to 
the name, the URL will only be the letters before the space even though the 

“Loom Name” shows the complete name with the space. 

GOOD EXAMPLES: myloom, my_loom, my-loom 

BAD EXAMPLES: my loom (loom would only show up as “my”) 

Note: 
If you ever forget the name of your loom you can always connect with the IP 

address. 

1) Once you have AVLDrive open, select the “Options” tab.  

 

 

2) In the box for Loom Name, enter the name you’d like to use for 
your loom. If the box is not blank, delete the existing name and 

enter the new text of your choice. 
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3) Click the enter button on your keyboard, or simply clicking 

anywhere on the page.  

4) Refresh or exit your browser. The COM light will turn off and 

then back on pretty quickly. In the Options Tab you’ll see the 
loom name has been changed. You will also see the Connected To: 

field under Please select file has changed. 

5) Type the new URL into your browser with your new Loom Name as 
shown in the beginning of this section: http:// + [loom name] + 

.local  

6) Click Enter on the keyboard. 

7) AVLDrive will refresh and the COM Light will light up once 

communication is established with the loom. You can now use this 
URL to access AVLDrive via USB, router, and LoomDirect.  

LOSS OF COMMUNICATION 

If the loom and the software does not seem to be communicating correctly, 

reload the AVLDrive page. 

1) Reload the AVLDrive page by pressing Ctrl+R(Windows) or 

Cmd+R(Mac). You can also click the reload icon on your browser. 

 

LOGOUT USER 

Normally when using a computer, the connection between the computer and 
the loom will be automatically terminated. When using a tablet, this may 

need to be done manually. See page 69 for instructions on how to deal with 
a busy message. 

REBOOT THE LOOM 

1) Enter “/reboot” after the URL or IP address in your web browser. 
The loom will reboot as if it had been shutdown and restarted. 
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SHUTDOWN THE LOOM 

If you will be removing the loom from a power source, you should shutdown 
the loom using the commands in the software first. This is similar to shutting 

down a computer so that it restarts correctly. 

1) In the software, go to the Utilities tab. 

2) Click Shutdown. 

3) Once the loom has completed the shutdown sequence, you can 

remove power from the loom. 

USING WEAVEPOINT 

Weavepoint 8.0.2.0 and above offers direct access to AVLDrive for your loom 

with Compu-Dobby 5. The loom control function in Weavepoint will open the 
software, and upload the pattern you have open in Weavepoint.  

Note: 

Weavepoint is a Windows-based program. If you want to activate AVLDrive 
directly from Weavepoint, you will need to use a Windows-based device. 

AVLDrive only works with WIF files. When a file is opened in AVLDrive using 

WeavePoint, the file has been exported from WeavePoint as a WIF and 
imported to AVLDrive. The WIF file will then be available on the File tab in 

AVLDrive for future use.  

Set Weave Options in WeavePoint 

1) Select Options on the Weave menu to open the Weave Options 
dialogue box.  
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2) Select Compu-Dobby 5.   

Note: 
Choosing Compu-Dobby 5 will launch AVLDrive with the pattern you have 

open. If this is selected, there will be no other options you can choose in 
Weave Options window. 

Connect to Loom 

1) Have the pattern you want to weave with open. You can use 

WeavePoint files or WIF files. 

2) Select Loom Control on the Weave menu. 

 



 Connecting to the Loom Compu-Dobby 5 User’s Manual 

Page | 22 Using Weavepoint 

3) Select USB if your loom is connected with a USB cable. If you are 

connecting to your loom wirelessly, choose WiFi. 

4) If WiFi is chosen, you must enter the Loom Address so that the 

connection will be made correctly. 

Note:  
You may use either the IP Address or the Loom Name for the Compu-Dobby 5. 

5) If you have a pattern open in WeavePoint, the pattern name will 

display here. 

6) Select Replace any existing pattern with same name if you want to 
overwrite a pattern already on the loom with the same name. 

7) If Start loom control with this pattern is checked, the pattern will 
open in the loom control so that it is ready for you to weave with. 

8) Click OK. A message that the pattern was uploaded will appear. 

 

9) Click OK. The pattern will open in AVLDrive in the Weaving tab. 
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WEAVING WITH 

THE COMPU-

DOBBY 5 
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No matter how you are connecting to the loom, the loom software will 

appear in your browser. Depending on the browser you are using, the 
software may appear subtly different from the pictures in this manual, 

however the functionality will be the same. 

Note: 

A section in this manual covers the additional functionality available for K-

series looms. See page 56. The Cloth Advance and Warp Tension sections 
shown in the software below are only available on the K-series loom. 

When you power on the loom using the software, the loom will go through a 

solenoid self-test. Once the self-test is complete, you will be able to continue 
using the software. 

The software allows you to make changes to the loom as you weave, 
including the pick to be woven. If the shed is closed, the changes will be 

made immediately as the button is pressed in the software. If the shed is 
not closed, the changes will be reflected in the Next field and will be made 

when the shed is returned to the closed state. 

OPEN A FILE FOR WEAVING 

1) Connect to the loom as described previously. The software defaults 

to the File tab. For complete information on the Files tab, including 
how to import files, see page 38. 
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2) Click a file from the list to select it. 

3) Click Open for Weaving. The Weaving tab will open with your 
selected file as shown in the next screenshot. 

Note: 

You can also double-click a file to open it for weaving. 

 

Power  

When you power on the loom using the software, the loom will go through a 

solenoid self-test. Once the self-test is complete, you will be able to continue 
using the software.  

Note: 
If you open a file for weaving (see page 24) when the loom is powered off, the 

loom will automatically power on. 

The Power button is used to turn weaving mode on/off. It is not used to 
completely Shutdown the loom. Shutting down the loom is done through the 

utilities tab and is only needed when preparing the loom to be unplugged 
from power.  

1) Click Power to boot up the loom.  
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2) The loom will begin a self-test. At the same time, the button will 

have a checkmark and the Power light on the interface will turn 
briefly yellow, then red.   

 

3) Once the loom has completed its self-test, you will be able to 
commence weaving. 

RESUME A WEAVING SESSION 

1) Connect to the loom as described previously. The software defaults 

to the File tab. For complete information on the Files tab, including 

how to import files, see page 38. 

 

2) Click the file that was last being used to resume the session. 

3) Click Open for Weaving. 
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4) The resume weaving dialog appears. Click OK to continue weaving. 

TABBY 

You may want to weave a tabby (plain weave) header before beginning your 
main pattern. The tabby tab allows you to choose the pattern that will create 

plain weave with the threading you are using. Once you have chosen the 
correct tabby on the Tabby tab, you will be able to switch to it at any point 

by clicking the Tabby button on the Weaving tab. For information on how to 
setup new tabbies, please see page 47. When selected, the tabby will begin 

with pick A. The tabby defaults include both “Odds and Evens” and “Evens 
and Odds.” Choose the best option depending on the last pick before the 

tabby section.  

1) Open the Tabby Tab by clicking on the name. The tabby will only 

show the number of shafts available on your loom. The following 

example was taken on a 40 shaft loom. 

 

2) From the drop-down menu, choose the tabby to use with your 
threading. Several defaults are available. 
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3) Return to the weaving tab. 

 

4) Click Tabby to switch to the pre-defined tabby. The pattern showing 
on the weaving tab will change to plain weave and the button will 

have a checkmark. The tabby will begin with pick A, which is the 
top pick shown on the Tabby tab. 

Note: 

If the pattern that is showing is not plain weave, you may have chosen the 
wrong tabby. Return to the tabby tab and change the tabby. 
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5) To return to the pattern, click the Tabby button. 

REVERSE 

The Reverse feature flips the pattern upside down and keeps you weaving 
forward. This is NOT used to unweave or to go backwards in your pattern. 

This could be used to provide symmetry in a pattern, for example, keeping 
the ends of a scarf the same when it is worn. 

1) Click Reverse to reverse the weaving pattern. This allows you to 

automatically reverse the weaving order of the WIF. 

 

2) The button will have a checkmark. Click the button again to return 
to the original pattern. 

SET THE RANGE 

The default range for the WIF is from the first to last pick. If you do not want 
to weave the whole pattern, enter the range of picks you want to use. Once 

you reach the end of the range, the range will repeat.  

Note: 
The Repeats section, under Picks, will indicate the number of times the range 

has been repeated. In the example below, when the 42nd pick is beaten, 
Repeats will show 1, when the 84th pick is beaten, Repeats will show 2. 
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Use this feature to experiment with different looks from the same WIF file. 
You could also choose a small section from a longer pattern to help create a 

set of differing sized items, for example, a table runner and napkins. 

1) In the Set Range Area, click Set Range. 

 

2) The Set Range window appears. 

 

3) Enter the Start and End Picks. Click Apply. 

The following examples show the full pattern, then 1-10 and then 1-15 were 

set as the range for the same WIF file. Each pattern appears slightly 
different. 

 



 Compu-Dobby 5 User’s Manual Weaving with the Compu-Dobby 5 

Set the Range Page | 31 
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UNWEAVE 

Note:  

Anytime you move the weaving backwards, you should loosen the tension on 
the cloth storage beam, or unwind some of the cloth. This will release the 

tension on your finished cloth so that nothing will be damaged. 

The Unweave button is used when you need to remove some of your weft 
threads. When you press down the treadle, the shed will open the picks in 

the reverse order that you wove. Once you have unwoven the desired 

amount, adjust the tension on your loom by rewinding any loose warp and 
adjusting the woven cloth so that the fell line is in the correct position. 

1) Unwind some of your woven cloth, or otherwise release the tension 
on the cloth storage beam. 

2) Click Unweave. 
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3) The button will now have a checkmark.  

4) When the loom is treadled, each shed that has been woven will 

open in reverse order so that you can remove the weft threads. 

5) Unweave the cloth until you are satisfied. 

6) Click the Unweave button to return to normal functionality. 

7) Wind any loose warp back on the warp beam. Adjust the fell line as 

needed. 

8) Adjust the tension on the loom as needed. 

9) Resume normal weaving. 

ADJUST THE PICK 

You can change the pick to be woven by using the right or left arrow keys on 

the keyboard, or by entering the exact pick number to weave. If the shed is 
closed, the solenoids will fire to adjust the pick. The display will be adjusted 

to show the changes. Changing the pick with the arrow keys is the fastest 
way to step through the design. 

When a range is set, the pick will “wrap around” when the value would stray 

outside the bounds set by the range. 

When opening the last file you used, most versions of the Compu-Dobby 5 

software will ask you if you want to resume where you left off at your last 
weaving session. If you have an older version, it may not save your last 

pick. In this case, enter the pick you want to start this weaving session with. 

You can also use this feature to start at a different pick then the one you left 
off at for design purposes. 

Note: 

Check the current pick to see what will be opened when you treadle. If the 
current pick is zero, treadle once to advance to the correct pick. 
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Change the Pick 

Note: 

Change the pick with the right or left arrow keys while the shed is closed to 
quickly step through the design. 

1) Press the right arrow on the keyboard to increase the pick by one. 

Press the left arrow on the keyboard to decrease the pick by one. 

Set the Pick 

1) In the Pick area, click Set Pick. 

 

2) The Set Pick window appears. 

 

3) Enter the pick you want to start with and click Apply. 

ZOOM IN ON THE WIF 

You can zoom in on the WIF in order to see it in more detail. You can zoom 
out on the WIF in order to see more of it. 

1) Click the + or – zoom buttons until you have adjusted the view of 

the WIF file to what you want. 
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The following examples show a weaving tab that is zoomed out, and then 

one that shows it zoomed in. 
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POWER OFF 

1) When you are done weaving, click Power to return the loom to its 
normal standby state. If you are going to turn off power to the 

loom, shutdown the loom through the software. 
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OTHER TABS 
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FILE TAB 

Files are stored on the loom. The files must be in the WIF format. The file 
tab allows you to open your weaving files or to transfer weaving files to the 

loom. It is the default tab that appears when you open the software. 

If you are using Weavepoint, you can use the loom control feature to open 
Weavepoint files directly in AVLDrive. With any other software, you must 

export your weaving files to the WIF format. With the Compu-Dobby 5, files 
are stored directly on the loom. From the files tab, you can open WIF files 

that have been stored on the loom. You can also upload files from your 
computer to the loom for use. 

Note: 

If no file is selected, only Transfer to Loom and Open, Upload to Loom, and 
Backup to Local Machine will be available. 

 

Button What it does 

Transfer to Loom and Open Transfer a file from local storage to the loom 

and open it. Complete instructions follow. 

Open for Weaving Opens the selected file for weaving. You can 
also double-click a file to open it for weaving. 

Rename Rename a file. For example if you have 

several files with similar names, you might 
rename the file you are actively using so that 

it is easy to find. 
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Delete Delete a file from the loom. While there are 

no limits on how many files can be stored, 
deleting files that are not being used can 

make it easier to find the files you want in the 
list. 

Upload to Loom Transfer a file to the loom without opening it. 

Complete instructions follow. 

Download from Loom For future use. 

Backup to Local Machine For future use. 

Transfer to Loom and Open 

This option allows you to find WIF files on your computer and transfer them 

to the loom storage system for use. The file will be transferred to and also 
opened in the Weaving tab for use. 

1) Click Transfer to Loom and Open. The standard open file window 

for your device will appear. This screenshot is from a Windows 
computer. 

 

2) Navigate to the folder where you have stored the WIF file you want 
to use. 

3) Choose the desired WIF file from the folder by clicking on it. 
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4) Click Open. 

5) The WIF file will open in the Weaving Tab in AVLDrive. 

Note: 
This process will upload the file to the loom, so the next time you want to use 

this WIF, you can choose it from the File tab. 

Upload to Loom 

This option will transfer the WIF file to the loom for use in the future, but it 
will not be opened in the Weaving tab. 

1) Click Upload to Loom. The standard open file window for your 

device will appear. This screenshot is from a Windows computer. 

 

2) Navigate to the folder where you have stored the WIF file you want 
to use. 

3) Choose the desired WIF file from the folder by clicking on it. 

4) Click Open. 

5) The WIF file will appear in the list of files in the Files tab. 



 Compu-Dobby 5 User’s Manual Other Tabs 

Options Tab Page | 41 

OPTIONS TAB 

This tab allows you to set several options for your loom. 

1) To activate an option, check the box. 

2) To turn off an option, uncheck the box. 

 

 

Note: 
Use metric (cm) for advance and Enable Cloth Beam Advance will only be 

available if your loom supports the automatic cloth beam advance. As of the 

publication of this manual, only the K-series loom supports Cloth Beam 
Advance. 

Loom Name 

The name of your loom. Changing the name will change the address you 

need to type to access your loom. See page 15 for complete instructions. 
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History Percent 

Move the percentage bar to indicate how much of the screen should be 

devoted to history. The following examples show a screen with more history 
and less history. 
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Show repeat counter 

This option shows the repeat number in the software. The Repeats number 

will indicate the number of times the range has been repeated. If the repeat 
includes picks 1-8, when the 8th pick is beaten, Repeats will show 1, when 

the 16th pick is beaten, Repeats will show 2. The following examples show 
the screen with the repeat counter on and with it off. 
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Show color bar 

The color bar to the right of the draft will appear. The following examples 

show the color bar on and the color bar off. 
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Show drawdown in color 

Allows you to view the WIF in color. This can be helpful when the design has 

the same color warp and weft. The following examples show the WIF in color 
and the WIF with the color option turned off. 
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Show numbers in liftplan 

When you are zoomed in far enough on the WIF, you will be able to see the 

harness numbers. The following example shows the WIF if you turn this 
option off. This is also what will appear if the file is zoomed too far out to 

show legible numbers. The examples for the color drawdown on the previous 
page show harness numbers. 

 

Fabric scrolls down 

If selected the fabric will scroll down on the screen as you weave, if not, the 
fabric will scroll up. The following example shows this option turned on. The 

other screenshots in this manual show the fabric scrolling up. 
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TABBY TAB 

This tab allows you to set up or use a tabby (plain weave). Several defaults 
are included. If your threading requires a tabby pattern that is not included, 

you can add a new tabby. You can also edit, delete, or rename existing 
tabbies. 

1) With the AVLDrive software open, click Tabby. 

 

2) To select a tabby, choose it from the drop-down menu. The tabby 
that appears in the tab is the one that will be selected when the 

Tabby button is clicked on the Weaving tab. 

Add a Tabby 

Once you have added a new tabby, you will need to edit so that the correct 
harnesses rise on each lift. 

1) Click Add. 
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2) Enter the name of the Tabby. 

3) Click OK. 

Edit a Tabby 

1) Choose the Tabby from the drop-down list. 

2) Click Edit. The background color of the tabby will change. 
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3) Click the harnesses that should rise on each lift. The top line is pick 

A and the bottom line is pick B. Pick A is the starting pick when 
Tabby is chosen on the weaving tab. 

4) When you are done, click Edit again. 

Delete a Tabby 

Note: 
The Default tabby cannot be deleted. 

1) Choose the Tabby from the drop-down list. 

2) Click Delete. 

 

3) Click OK at the confirmation window. 

Rename a Tabby 

Note: 
The Default tabby cannot be renamed. 

1) Choose a Tabby from the drop-down list. 

2) Click Rename. 
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3) Enter the new name in the window and click OK. 

Use a Tabby 

When you change the tabby in the drop-down menu, you change the tabby 
that will be used by the loom when you click Tabby on the Weaving tab. 

1) Open the Tabby Tab by clicking on the name. The tabby will only 

show the number of shafts available on your loom. 

 

2) From the drop-down menu, choose the tabby to use with your 
threading. Several defaults are available. 
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UTILITIES 

This tab allows you to perform several operations for your loom. 

 

 

Button What it does 

Check for update Checks to see if there are updates for the loom 

software. The loom must be connected to the 
internet. 

Fetch configuration Gets configuration information for your software. 

The loom must be connected to the internet. Only 
click this when told to by AVL personnel.  

Show Log Displays a log of software events. This window can 

be selected and copied to send to AVL for 
diagnostics if necessary. If the loom is connected 

to the internet, the information can be sent by 
email automatically. You can also copy the log and 

paste the information into an email. 

Shutdown Shuts down the loom safely so that it can be 
removed from power. 
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DIAGNOSTICS 

This tab allows you to view information about your solenoids. If this 
information is needed, you will be directed to view it by AVL personnel. 
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ADDITIONAL 

FUNCTIONS: K-

SERIES LOOM 
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WARP BEAMS AND AUTOMATIC WARP TENSION SYSTEM  

A first in our industry, the K-series loom offers digital control of warp tension 
using a small electrical motor and drive system connected via spring and 

brake cable to the warp beam. The motor is controlled by the Compu-Dobby 
& AVLDrive. Easily change the warp tension at any time during weaving by a 

click of the mouse or a touch of the finger on the touchscreen. This system 
allows very fine, repeatable control with a range from locked beam to free 

turning for winding on the warp. 

Automatic cloth advance is an AVL-only feature on hand weaving looms. 
Earlier mechanical versions of these systems are well known for providing 

fine control over pick advance spacing. This feature utilizes digital controls 
via an electric motor driven worm and gear attached directly to the cloth 

beam. Much like the digital warp tension controls, set the picks per inch in 
AVLDrive and start weaving. Easily change the advance setting or manually 

advance the cloth at any time during weaving by a click of the mouse or a 
touch of the finger on the touchscreen. This system allows very fine, 

repeatable control with a range from hundreds of picks per inch (or 
centimeter) to gross movements needed when starting a new warp. 

LOOM SELF-TESTS 

When you power on the loom using the software, the K-series loom will go 
through a series of self-tests: The solenoid self-test, the warp tension motor 

initialization, and (if the loom has two warp beams) the second warp tension 
motor initialization. A notification will appear in the software letting you 

know that the tension system is calibrating. It will be removed when the 
calibration is complete. If you have one warp tension motor, the process will 

take about 90 seconds. If you have two, it will be about 180 seconds. Once 
the self-tests are complete, you will be able to continue using the software. 

WARPING THE LOOM 

Looms with automatic warp tension motors are designed to allow you to 
wind on the warp without removing the tension cable. A button on the 

Weaving tab allows you to set the tension to the lowest setting.  

1) Connect to the loom as described previously. The software defaults 
to the File tab. 
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2) Open the Weaving tab. You do not need to have a weaving file 

open. 

Note: 

If you open a file for weaving (see page 24) when the loom is powered off, the 

loom will automatically power on. 

3) Click Power to boot up the loom.  

 

4) The loom will begin its self-tests. At the same time, the button will 
gain a checkmark and the Power light on the interface will turn 

briefly yellow, then red.  

 

5) Click the free warp tension button. 

 

6) The button will turn red to indicate it is activated. Click the button 
again to turn it off. 
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7) Wind the warp onto the warp beam. For more information, see the 
weaving section in your loom manual. 

8) You can click Power to return the loom to standby when threading 
the heddles and reed. If you are going to turn off power to the 

loom, shutdown the loom through the software. 

CONTROLLING THE CLOTH ADVANCE 

The cloth advance controls allow you to advance the warp without weaving, 

or reverse the warp. You can also set the picks per inch (PPI). The default 
PPI is 15. 

Set the PPI 

The default for the cloth advance is picks per inch, but you can change 

inches to centimeters in the options tab. See page 62 for instructions on 
changing to centimeters. 

It’s important to note that PPI can be affected by types of yarn and the sett, 

so please use the PPI as indicated in the Cloth Advance Box as a starting 
point, and understand that numbers may need to be adjusted to get the 

correct PPI on the cloth. However, once you have the PPI set, it will not 
change on the cloth until adjusted in the software. 

1) In the software go to the Cloth Advance area and click in the PPI 

field.  

 

2) Use the small arrow keys to change the value, or click in the field 
and type in the value you want. You can enter fractional values 

when typing, for example “15.25”. 
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Note: 

If you want to advance the warp quickly, for example when warping the loom, 
set the PPI to one. 

Advance the Warp 

Typically, you manually advance forward to bring the fell line to the correct 

weaving position after you have warped the loom. The correct position is 
when the beater arms hit the bumpers and the fell line is at the reed. 

 

3) In the software go to the Cloth Advance area.  

 

4) Use the up arrow to advance the warp. Click the arrow until the 
warp has advanced as far as you want it. 

SET WARP TENSION 

You can set the tension by entering a number in the field or by using the up 
and down arrows on the field. The default tension is set at 55. 

When the loom is powered on for weaving, the warp tension motor will 

search for its reference home, then return to the tension setting left by the 
weaver in the previous weaving session. 
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1) In the software go to the Warp Tension field. Use the arrow keys to 

change the value, or click in the field and type in the value you 
want. 

 

UNWEAVE 

WARNING:  

Anytime you move the weaving backwards, you must remove the pin in the 
cloth storage beam. This will release the tension on your finished cloth so 

that the loom will not be damaged. 

The Unweave button is used when you need to remove some of your weft 
threads. When you press down the treadle, the shed will open the picks in 

the reverse order that you wove. The warp beam will move backwards when 
Unweave is selected. Once you have removed the weft back to the desired 

point, you can use the manual advance buttons in the cloth advance section 
of the Weaving tab to adjust your fell line back to the proper point if 

necessary. 

1) Take the pin out of the cloth advance beam so that the cloth will 
unwind easily. 
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2) Click Unweave. 

 

3) The button will now have a checkmark.  

4) The Cloth Advance will be disabled until you click the Unweave 

button again. 

5) When the loom is treadled, each shed that has been woven will 

open in reverse order so that you can remove the weft threads. 

6) Unweave the cloth until you are satisfied. 

7) Click the button to return to normal functionality. 

8) Wind any loose warp back on the warp beam. Adjust the fell line as 
needed. 

9) Place the pin back in the cloth advance beam. 

10) Adjust the tension on the loom as necessary. 

11) Resume normal weaving. 
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Reverse the Warp 

Use this option to adjust the fell line if necessary.  

1) Make sure the pin is out of the cloth advance beam so that the cloth 
will unwind easily 

2) In the software go to the Cloth Advance area.  

 

3) Use the down arrow to reverse the warp. Click the arrow until the 
warp has reversed as far as you want it. Use the beater to adjust 

the fell line. 

4) Reset the tension. Depending on how far you have unwoven, you 

may need to rewind the warp onto the warp beam. 

5) Return the pin to the cloth advance beam. 

Note: 
If you cannot find the hole for the pin easily, move the cloth advance beam by 

using the beater until you see the hole. The cloth advance beam will not wind 
on cloth unless the pin is in the hole. 

6) If there is any slack in the cloth you can tighten up by using the 

beater. 

LOCK THE WARP BEAM 

There is a button that allows you to lock the warp beam in place. When the 

warp beam is locked, the cloth advance is automatically disabled. 

This feature could be used by weavers who want to be able to experiment 
with placing wefts while manually advancing the cloth and letting off warp.  

If you need to treadle through your pattern for some reason, you can use 
this feature to avoid having the warp advance, however it is faster to turn 

off the cloth advance without locking the warp beam. See page 62. 

Note: 
Change the pick with the right or left arrow keys while the shed is closed to 
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quickly step through the design. You do not need to lock the warp beam or 

turn off the cloth advance. 

1) Open the software.  

2) Click the Lock warp beam button. 

 

3) Click the button again to turn it off. 

 

OPTIONS TAB 

Most of these options are available for all Compu-Dobby 5 looms and are 
covered starting on page 41. The options discussed in this section are only 

available on the K-series loom. 

1) To activate an option, check the box. 

2) To turn off an option, uncheck the box. 
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Enable Cloth Beam Advance 

This option allows you to turn on or off the cloth beam advance. The cloth 
beam advance is also turned off if the warp beam is locked. This can be used 

to halt the cloth advance when stepping through the design. 

Use metric (cm) for advance 

This option allows you to use the metric system for the cloth advance, if 
available. The default is imperial (inches). 
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TROUBLE-

SHOOTING THE 

COMPU-DOBBY 5 
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SEND TROUBLESHOOTING INFORMATION TO AVL 

If you are having problems with your loom, AVL may ask you to send the log 
file generated by the program to them in order to figure out the problem. In 

some cases, the log file may be so large that you have problems sending it. 
Follow these instructions to make the log file easier to handle. In order to 

use this option, you will need to be able to recreate the issue. 

1) Enter “/reboot” after the URL or IP address in your web browser. 
The loom should reboot - this clears the log file. 

Note: 

The option to reboot the loom was added in v.1.2.0. If your loom is on a 
previous version, you will need to shutdown the loom completely, then turn it 

back on. 

2) Wait for the loom to reboot and for the network to reconnect. This 
may take a couple of minutes. 

3) Reload AVLDrive. The reboot will cause the browser to disconnect.  

4) Perform the actions in the software or on the loom that cause the 
problem. Repeat the actions a few times. 

5) Start an email to AVL explaining the problem. In the email, explain 

what actions you take, what results and error messages you 
receive, and how many times the problem occurred. 

6) Choose the Utilities tab. 
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7) Click Show Log. 

 

8) Select all of the text in the log file. 

9) Copy the log file and paste into the email. Send the email to 

sales@avlusa.com. 

 

mailto:sales@avlusa.com
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APPENDIX I – 

ADDITIONAL 

INFORMATION 
  



 Appendix I – Additional Information Compu-Dobby 5 User’s Manual 

Page | 68 Using a Tablet with Compu-Dobby 5 

USING A TABLET WITH COMPU-DOBBY 5 

Sometimes it is difficult to find the right place to put a computer for weaving 
on your loom. It seems like it is either in the way, at risk of an errant fly 

shuttle, or too far out of your normal visual range. Putting it on a chair next 
to the loom is a bit too low and requires you to turn too so far that you have 

trouble keeping your rhythm. 

One solution is to use a tablet. A tablet is a great way to weave with the 
Compu-Dobby 5. With the addition of a mounting arm it can be positioned so 

that it is at the correct height while not obstructing your view of the action 
of the loom. And it can be moved out of the way with just a push. 

AVL does not recommend specific tablets or operating systems. There are 
many manufacturers and models to choose from; too many for us to 

monitor. With the operating systems in common use today, iPads are able to 

use the “loomName.local” style of address. However, the Android tablets do 
not support “.local” so the standard IP address will need to be used. See 

page 16 for more information about the loom name and IP addresses. 

Choosing an arm  

The first thing is to choose how you will attach the arm to the loom. Many 
arms attach with a clamp while some will need screw holes in the frame of 

the loom. A clamp is not usually as stable as a more permanent mounting 
and if you want to be able to move the tablet aside with a quick swipe of the 

hand, it may not be the best choice. 

Another consideration is the capacity of the arm. If you are thinking of using 

a large tablet like the 13” iPad, many of the arms cannot support that size 
tablet. With the mechanical motion of the loom, you will need a fairly robust 

arm to keep it from drooping. So, check that both the size and the weight 
capacity of the arm are sufficient. 

Choosing a tablet 

The tablet needs a minimum resolution of 1024 x 768 pixels. On the iPad 

Retina displays that translates to needing 2048 x 1536 pixels. We have 
followed industry standards while creating AVLDrive so the tablet needs a 

browser that is consistent with current standards.  

A USB cable connection is not required. The loom will automatically connect 
to your router (if it has been configured to do so) or it will create its own 

private network. See page 11 and following for more information. 
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Reset the connection 

Unlike computers many tablets are designed to be turned off and on without 
disturbing existing connections. In many cases, when you are finished with 

AVLDrive on a tablet you will need to reset the connection for the loom. This 

happens automatically with computers, but because of the difference in the 
way connections are handled by tablets, it becomes a manual step. If you 

forget, the next time you attempt to connect to the loom you will probably 
get a busy message, and you can send a logout message at that time. 

1) When connecting to the loom, you receive the message below. 

 

2) Enter “/logout” after the URL or IP address in your web browser.  

3) Refresh your page.  

 

4) Once you receive the notification that the “current user has been 
logged out”, simply reenter your normal URL or IP address.  
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COMPU-DOBBY 5 CONNECTION INFORMATION 

The Compu-Dobby 5 uses a connection known as “http,” which your browser 
may indicate is unsafe. Since no personal information is passed over the 

connection, additional security is not required. 
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THE FINE PRINT 
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AVL CUSTOMER SERVICE 

AVL offers free technical support to the original owner of all our looms.This 

means if you ever have a problem, you can call, fax, or e-mail us and we’ll 
help you find a solution.Please take advantage of this service; your 

satisfaction is extremely important to us. 

Customer Service Phone: (530) 893-4915 

Fax:(530) 893-1372 

E-Mail:sales@avlusa.com 

AVL WARRANTIES 

Limited Warranty:The benefits of this warranty accrue solely to the original purchaser of AVL Looms, 
Inc. products, as defined below. 
 
Your warranty covers: 
 
New Looms: AVL Looms, Inc., a California corporation (“AVL”) warrants to the original purchaser of any 
AVL loom (each, a "Product") that the Product will be free from defects in materials and workmanship 
during the limited warranty period described herein. The limited warranty coverage begins (a) the day 
the Product is installed if installed by a professional from AVL, or (b) on the date of shipment from AVL 
to the original purchaser if the Product is not installed by AVL (the “Effective Date”). Except as set forth 
under the section entitled “What is Excluded?” below, AVL will, for a period of two (2) years from the 
Effective Date (the “Original Warranty Period”), repair or replace the defective part(s) of the Product with 
a repaired, renewed, or comparable part (whichever is deemed necessary or proper by AVL) if it 
becomes defective or inoperative or fails to perform according to AVL’s specifications. Any repair during 
the Original Warranty Period will be carried out without charge to you for parts (except applicable taxes, 
if any). You will be responsible for all labor in connection with installation of the parts and service upon 
the Product, as well as the cost of shipping involved. 

 
New Accessories, Loom Upgrade Parts, and Replacement Parts:Subject to the limitation contained in 
subsection (i) under the section entitled “What is Excluded?” below, AVL warrants to the original 
purchaser of any accessory, loom upgrade parts, or loom replacement parts (the “Additional Part”) that 
are sold by AVL that such Additional Part will be free from defects in materials and workmanship for 
ninety (90) days from the date of purchase. In the event that any Additional Part is physically damaged or 
physically defective and if such defective Additional Part is returned to AVL within ninety (90) days of the 
date of purchase, AVL will provide a replacement Additional Part at no charge. The sole remedy for this 
warranty shall be limited to the replacement of the defective Additional Part. You are responsible for all 
shipping charges (including applicable taxes) incurred with returning the defective Additional Part. 
 
All New Products and their components (including replacement Product and its components) are covered 
only for the Original Warranty Period. When the warranty on the original Product expires, the warranty on 
any replacement Product, or components also expires. After two (2) years from the Effective Date, you 
pay for any replacement or repair, including all parts, all labor and shipping charges (including applicable 
taxes). 
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Your warranty does not cover: 

1.Labor charges for installation or set-up of the Product, as well as any labor charges required to 
install, disassemble, troubleshoot, or reassemble the Product. 

2.Any taxes imposed on AVL for Product replacement or repair under this warranty. 

3.Installation, performance of, or repair of: cabling, electrical, or accessory attachments used with the 
Product. 

4.Product replacement or repair because of misuse, accident, repair by any party other than AVL, or 
other cause not within the control of AVL. Please note that removing any parts from the Product for any 
reason voids the warranty. 

5.Incidental or consequential damages resulting from the Product. 

6.A Product that has been modified or adapted to enable it to operate in any country other than the 
United States or any repair of Products damaged by these modifications. 

7.Electrical and pneumatic components, each of which carries a one (1) year warranty from the 
Effective Date. 

8.Jacquard components function beyond 98%. A Jacquard module is considered to be operating within 
specification if 98% of all hooks are operating as commanded. 

9.Computing equipment, such as a Personal Digital Assistant or a Personal Computer, which are 
manufactured by a third party(ies) and which may be under warranty through the original manufacturer. 
AVL is not responsible for any warranty coverage that may be offered concerning these products and 
you must contact those manufacturers directly regarding any available warranty coverage.  

The performance or functionality of any software that is sold either together or separate from the Product. 
The AVL warranty covers only defects in the Software Media, namely the CD-ROM media such as a 
broken CD-ROM or a defect in the CD-ROM that would prevent the CD-ROM from being read by your 

personal computer's CD-ROM drive.. 

AVL Returns Policy 

Any order that has left AVL in transit to the customer is considered fulfilled. 

Parts and accessories not covered under warranty must be returned to AVL 
within 60 days from the date of shipment from AVL. The purchase price of 

the item(s) is refundable less a 15% re-stocking fee based on the total 
purchase price. No refunds will be given on shipping or handling. The buyer 

is responsible to return the merchandise in "as new" condition at their 
expense. Any item received showing wear or damage is not eligible for 

return and will be promptly returned to the customer COD unless some other 
arrangement is made. Looms and custom-made items, special order items, 

parts made for pre-1998 looms, used and reconditioned items are not 
eligible for return.


